
���

 

IBM

 

Datacenter

 

Solution

 

xSeries

 

445

 

Upgrade

 

Instructions

 

This

 

document

 

is

 

intended

 

for

 

upgrading

 

an

 

existing

 

Microsoft®

 

Windows®

 

2000

 

Datacenter

 

Server

 

installation

 

on

 

an

 

IBM®

 

ERserver

™

 

xSeries®

 

445

 

server

 

to

 

Microsoft

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition.

 

This

 

document

 

is

 

also

 

available

 

in

 

HTML

 

format

 

as

 

a

 

README.HTM

 

file

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

that

 

comes

 

with

 

this

 

upgrade

 

package.

  

Attention:

  

Please

 

read

 

this

 

document

 

completely

 

before

 

beginning

 

the

 

upgrade

 

process,

 

and

 

make

 

sure

 

that

 

you

 

complete

 

the

 

steps

 

in

 

the

 

order

 

that

 

they

 

appear

 

within

 

this

 

document.

 

Also,

 

do

 

not

 

leave

 

your

 

server

 

unattended

 

during

 

the

 

upgrade

 

process.

 

What

 

you

 

will

 

need

 

You

 

must

 

have

 

the

 

following

 

software

 

and

 

hardware

 

available

 

during

 

the

 

upgrade

 

process:

 

v

   

One

 

licensed

 

copy

 

of

 

the

 

Microsoft

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

(the

 

IBM

 

Datacenter

 

Upgrade

 

CD

 

provided

 

with

 

this

 

upgrade

 

package)

 

v

   

The

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

provided

 

with

 

this

 

upgrade

 

package

 

v

   

IBM

 

ServeRAID™

 

Setup

 

CD

 

version

 

6.11.07

 

v

   

Blank

 

diskettes

 

to

 

create

 

driver

 

diskettes

 

for

 

the

 

following:

 

–

   

IBM

 

custom

 

HAL

 

for

 

the

 

xSeries

 

445

 

server

 

–

   

IBM

 

ServeRAID

 

Driver

 

6.11.07

 

for

 

the

 

xSeries

 

445

 

server

 

–

   

IBM

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

firmware

 

update

Important:

  

You

 

must

 

create

 

these

 

diskettes

 

before

 

you

 

begin

 

the

 

upgrade

 

procedure.

 

Once

 

you

 

have

 

everything

 

you

 

need,

 

you

 

will

 

complete

 

the

 

following

 

procedures

 

during

 

the

 

upgrade

 

process:

 

1.

   

“Creating

 

HAL

 

and

 

other

 

diskettes

 

from

 

the

 

CD”

 

on

 

page

 

2

 

2.

   

“Removing

 

and

 

disconnecting

 

devices

 

before

 

upgrading”

 

on

 

page

 

3

 

3.

   

“Upgrading

 

the

 

operating

 

system”

 

on

 

page

 

4

 

4.

   

“Installing

 

and

 

updating

 

device

 

drivers

 

and

 

firmware”

 

on

 

page

 

5

 

5.

   

“Completing

 

the

 

upgrade”

 

on

 

page

 

11

  



Creating

 

HAL

 

and

 

other

 

diskettes

 

from

 

the

 

CD

 

Complete

 

the

 

following

 

steps

 

to

 

create

 

the

 

required

 

HAL

 

and

 

other

 

diskettes

 

before

 

you

 

begin

 

the

 

upgrade

 

process.

 

1.

   

From

 

any

 

server

 

with

 

a

 

Microsoft

 

Windows

 

operating

 

system

 

installed,

 

insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

that

 

comes

 

with

 

this

 

upgrade

 

package

 

into

 

the

 

DVD-ROM

 

drive.

 

2.

   

Create

 

the

 

HAL

 

diskette:

 

a.

   

Insert

 

one

 

of

 

the

 

blank

 

diskettes

 

into

 

the

 

server

 

diskette

 

drive.

 

b.

   

Copy

 

the

 

contents

 

of

 

the

 

HAL\

 

directory

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

to

 

the

 

diskette.

 

c.

   

Remove

 

the

 

diskette

 

when

 

done;

 

then,

 

label

 

the

 

diskette.
3.

   

Create

 

the

 

ServeRAID

 

6.11.07

 

device

 

driver

 

diskettes:

 

a.

   

Insert

 

one

 

of

 

the

 

blank

 

diskettes

 

into

 

the

 

server

 

diskette

 

drive.

 

b.

   

Copy

 

the

 

contents

 

of

 

the

 

SCSI\SRAID\DRIVER\

 

directory

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

to

 

the

 

diskette.

 

c.

   

Remove

 

the

 

diskette

 

when

 

done;

 

then,

 

label

 

the

 

diskette.
4.

   

Create

 

the

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

device

 

driver

 

diskettes:

 

a.

   

Insert

 

one

 

of

 

the

 

blank

 

diskettes

 

into

 

the

 

server

 

diskette

 

drive.

 

b.

   

In

 

the

 

HBA\QL2300\BIOS\

 

directory

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD,

 

run

 

the

 

25K9279.EXE

 

program.

 

c.

   

Follow

 

the

 

on-screen

 

instructions

 

to

 

create

 

the

 

diskette.

 

d.

   

Remove

 

the

 

diskette

 

when

 

done;

 

then,

 

label

 

the

 

diskette.
5.

   

Continue

 

with

 

“Removing

 

and

 

disconnecting

 

devices

 

before

 

upgrading”

 

on

 

page

 

3

 

to

 

prepare

 

your

 

xSeries

 

445

 

for

 

the

 

operating

 

system

 

upgrade.
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Removing

 

and

 

disconnecting

 

devices

 

before

 

upgrading

 

Before

 

you

 

continue

 

the

 

upgrade

 

process,

 

complete

 

the

 

following

 

steps

 

to

 

prepare

 

your

 

xSeries

 

445

 

server

 

for

 

the

 

upgrade.

  

Attention:

  

If

 

you

 

have

 

an

 

existing

 

IBM

 

TotalStorage®

 

FAStT

 

storage

 

subsystem

 

as

 

part

 

of

 

your

 

current

 

installation,

 

you

 

can

 

only

 

perform

 

this

 

upgrade

 

under

 

the

 

following

 

conditions:

 

v

   

The

 

storage

 

subsystem

 

is

 

not

 

the

 

startup

 

device.

 

v

   

The

 

Fibre

 

Channel

 

controllers

 

are

 

running

 

firmware

 

version

 

04.00.00.00

 

or

 

higher.
1.

   

Update

 

the

 

ServeRAID

 

4-MX

 

or

 

ServeRAID

 

6M

 

firmware,

 

using

 

the

 

ServeRAID

 

6.11.07

 

Setup

 

CD:

 

a.

   

Turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

insert

 

the

 

IBM

 

ServeRAID

 

Setup

 

CD

 

into

 

the

 

DVD-ROM

 

drive.

 

The

 

ServeRAID

 

configuration

 

program

 

will

 

start

 

automatically.

 

b.

   

When

 

the

 

window

 

is

 

displayed

 

that

 

contains

 

the

 

current

 

firmware

 

levels

 

for

 

the

 

ServeRAID

 

adapter,

 

click

 

Update

 

to

 

update

 

the

 

firmware

 

levels.

 

c.

   

Wait

 

for

 

the

 

firmware

 

update

 

to

 

complete;

 

then,

 

restart

 

the

 

server

 

and

 

remove

 

the

 

IBM

 

ServeRAID

 

Setup

 

CD

 

as

 

instructed.
2.

   

If

 

you

 

have

 

an

 

IBM

 

Remote

 

Expansion

 

Enclosure,

 

such

 

as

 

an

 

IBM

 

RXE-100,

 

connected

 

to

 

your

 

server,

 

you

 

must

 

disconnect

 

it

 

at

 

this

 

time.

 

Follow

 

the

 

instructions

 

in

 

the

 

documentation

 

that

 

comes

 

with

 

your

 

server

 

or

 

expansion

 

enclosure

 

for

 

disconnect

 

instructions.

 

Note:

  

After

 

upgrading

 

the

 

operating

 

system,

 

you

 

can

 

reconnect

 

the

 

RXE-100

 

according

 

to

 

“Connecting

 

an

 

RXE-100”

 

on

 

page

 

5.

 

3.

   

Uninstall

 

IBM

 

TotalStorage

 

FAStT

 

Storage

 

Management

 

software:

  

Attention:

  

To

 

avoid

 

possible

 

data

 

loss,

 

you

 

must

 

uninstall

 

any

 

existing

 

versions

 

of

 

this

 

software

 

before

 

upgrading

 

the

 

operating

 

system.

 

After

 

the

 

upgrade,

 

you

 

can

 

reinstall

 

the

 

FAStT

 

Storage

 

Management

 

software.

 

a.

   

From

 

the

 

Start

 

menu,

 

select

 

Settings→Control

 

Panel→Add/Remove

 

Programs.

 

b.

   

Uninstall

 

each

 

of

 

the

 

following:

 

SMagent,

 

SMutil,

 

and

 

RDAC.

 

c.

   

Restart

 

the

 

server.

 

d.

   

Uninstall

 

SMclient.
4.

   

Continue

 

with

 

“Upgrading

 

the

 

operating

 

system”

 

on

 

page

 

4

 

to

 

begin

 

upgrading

 

the

 

operating

 

system

 

on

 

your

 

server.
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Upgrading

 

the

 

operating

 

system

 

Before

 

you

 

continue

 

the

 

upgrade

 

process,

 

make

 

sure

 

that

 

you

 

have

 

read

 

this

 

entire

 

document

 

completely,

 

have

 

created

 

the

 

required

 

diskettes

 

according

 

to

 

“Creating

 

HAL

 

and

 

other

 

diskettes

 

from

 

the

 

CD”

 

on

 

page

 

2,

 

and

 

have

 

completed

 

the

 

steps

 

in

 

“Removing

 

and

 

disconnecting

 

devices

 

before

 

upgrading”

 

on

 

page

 

3.

 

Complete

 

the

 

following

 

steps

 

to

 

upgrade

 

the

 

operating

 

system

 

on

 

your

 

server.

  

1.

   

Turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

2000

 

Datacenter

 

Server

 

operating

 

system

 

to

 

start.

  

2.

   

Log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

  

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Upgrade

 

CD

 

that

 

comes

 

with

 

this

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

upgrade

 

package.

 

When

 

prompted,

 

select

 

Exit.

  

4.

   

From

 

a

 

command

 

prompt,

 

type

 

<DVD-ROM>:i386\winnt32

 

/s:<DVD-ROM>:\i386

 

/unattend:<DVD-ROM>:\i386\winnt.sif

 

(where

 

<DVD-ROM>

 

represents

 

the

 

drive

 

letter

 

of

 

the

 

server

 

DVD-ROM

 

drive)

 

and

 

press

 

Enter.

 

Installation

 

files

 

are

 

copied

 

from

 

the

 

CD

 

to

 

the

 

hard

 

disk

 

drive.

 

This

 

process

 

could

 

take

 

several

 

minutes

 

to

 

complete;

 

then,

 

the

 

server

 

will

 

automatically

 

restart.

  

5.

   

After

 

the

 

server

 

restarts,

 

the

 

OS

 

loader

 

menu

 

displays.

 

A

 

few

 

seconds

 

later

 

the

 

Windows

 

Setup

 

screen

 

displays

 

and

 

the

 

message

 

Press

 

F6

 

if

 

you

 

need

 

to

 

Install

 

third

 

party

 

SCSI

 

or

 

RAID

 

drivers

 

displays.

 

Press

 

the

 

F5

 

and

 

F6

 

keys

 

on

 

the

 

keyboard

 

while

 

this

 

message

 

is

 

displayed.

  

Attention:

  

Pressing

 

the

 

F5

 

and

 

F6

 

keys

 

allows

 

you

 

to

 

specify

 

installation

 

of

 

the

 

custom

 

HAL

 

and

 

ServeRAID

 

device

 

driver

 

from

 

the

 

diskettes

 

you

 

created

 

earlier.

 

You

 

have

 

only

 

a

 

few

 

seconds

 

to

 

press

 

this

 

key

 

combination

 

on

 

the

 

keyboard.

 

You

 

must

 

specify

 

the

 

custom

 

HAL

 

during

 

the

 

upgrade

 

process.

 

Failure

 

to

 

do

 

so

 

can

 

cause

 

your

 

server

 

operating

 

system

 

to

 

behave

 

unexpectedly.

 

If

 

you

 

do

 

not

 

press

 

these

 

keys

 

in

 

time,

 

you

 

must

 

stop

 

the

 

upgrade

 

process

 

and

 

begin

 

at

 

step

 

1

 

again.

  

6.

   

When

 

prompted,

 

select

 

Other

 

as

 

the

 

Computer

 

Type

 

and

 

press

 

Enter.

  

7.

   

Insert

 

the

 

HAL

 

diskette

 

that

 

you

 

created

 

earlier

 

into

 

the

 

server

 

diskette

 

drive;

 

then,

 

press

 

Enter

 

to

 

install

 

the

 

custom

 

HAL.

  

8.

   

When

 

prompted

 

for

 

a

 

Mass

 

storage

 

device

 

driver,

 

press

 

S

 

to

 

specify

 

additional

 

device

 

drivers;

 

then,

 

remove

 

the

 

HAL

 

diskette

 

and

 

insert

 

the

 

ServeRAID

 

device

 

driver

 

diskette

 

that

 

you

 

created

 

earlier

 

into

 

the

 

server

 

diskette

 

drive

 

and

 

press

 

Enter.

  

9.

   

Select

 

IBM

 

ServeRAID

 

4M/4Lx/5i/6M/6i

 

Controller

 

(Windows

 

Server

 

2003)

 

from

 

the

 

menu;

 

then

 

press

 

Enter.

 

Press

 

S

 

again

 

to

 

install

 

the

 

ServeRAID

 

device

 

driver

 

from

 

the

 

diskette.

 

10.

   

When

 

prompted

 

that

 

the

 

Windows

 

Setup

 

will

 

load

 

support

 

for

 

the

 

mass

 

storage

 

devices,

 

press

 

Enter

 

to

 

continue.

 

The

 

installation

 

file

 

copying

 

process

 

will

 

continue.

 

You

 

will

 

be

 

prompted

 

to

 

insert

 

the

 

HAL

 

diskette

 

again

 

during

 

this

 

process.

 

This

 

process

 

could

 

take

 

several

 

minutes

 

to

 

complete.

 

Remove

 

the

 

HAL

 

diskette

 

after

 

the

 

file

 

copying

 

process

 

completes.

 

The

 

server

 

will

 

restart

 

and

 

the

 

graphical

 

user

 

interface

 

(GUI)

 

for

 

Windows

 

Setup

 

will

 

continue

 

the

 

upgrade

 

process.

 

During

 

this

 

process,

 

setup

 

will

 

automatically

 

install

 

and

 

configure

 

detected

 

devices

 

in

 

the

 

server.

 

11.

   

After

 

the

 

operating

 

system

 

installation

 

completes,

 

remove

 

the

 

IBM

 

Datacenter

 

Upgrade

 

CD

 

from

 

the

 

DVD-ROM

 

drive;

 

then,

 

click

 

Finish.

 

The

 

server

 

will

 

restart

 

automatically.

 

12.

   

Log

 

in

 

to

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system;

 

then,

 

continue

 

with

 

“Installing

 

and

 

updating

 

device

 

drivers

 

and

 

firmware”

 

on

 

page

 

5

 

to

 

continue

 

configuring

 

your

 

server.

 

Note:

  

For

 

more

 

information

 

about

 

the

 

operating

 

system,

 

see

 

the

 

Microsoft

 

documentation

 

that

 

comes

 

with

 

this

 

upgrade

 

package

 

and

 

the

 

online

 

help

 

for

 

the

 

operating

 

system.
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Installing

 

and

 

updating

 

device

 

drivers

 

and

 

firmware

 

After

 

upgrading

 

the

 

operating

 

system

 

on

 

your

 

server

 

to

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition,

 

you

 

must

 

update

 

some

 

of

 

the

 

device

 

drivers.

 

You

 

can

 

also

 

connect

 

your

 

RXE-100

 

expansion

 

enclosure,

 

if

 

applicable,

 

and

 

other

 

devices

 

to

 

your

 

server

 

at

 

this

 

time.

 

Continue

 

with

 

the

 

following

 

sections

 

in

 

order

 

as

 

applicable

 

for

 

your

 

IBM

 

Datacenter

 

Solution

 

configuration:

 

1.

   

“Connecting

 

an

 

RXE-100”

 

2.

   

(Remote

 

Supervisor

 

Adapter

 

II-EXA

 

models

 

only)

 

“Updating

 

the

 

ATI

 

Radeon

 

video

 

device

 

driver

 

(Remote

 

Supervisor

 

Adapter

 

II-EXA

 

models

 

only)”

 

3.

   

“Updating

 

the

 

Broadcom

 

NetXtreme

 

Gigabit

 

Ethernet

 

adapter

 

device

 

driver”

 

on

 

page

 

6

 

4.

   

“Updating

 

the

 

LSI

 

1030

 

on-board

 

SCSI

 

device

 

driver”

 

on

 

page

 

6

 

5.

   

“Updating

 

the

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

device

 

driver

 

and

 

firmware”

 

on

 

page

 

7

 

6.

   

“Installing

 

TotalStorage

 

FAStT

 

Storage

 

Manager

 

software”

 

on

 

page

 

8

 

7.

   

“Updating

 

storage-subsystem

 

firmware”

 

on

 

page

 

10

Connecting

 

an

 

RXE-100

 

If

 

you

 

have

 

an

 

RXE-100,

 

complete

 

the

 

following

 

steps

 

to

 

connect

 

it

 

to

 

your

 

server:

 

1.

   

Shut

 

down

 

the

 

operating

 

system

 

and

 

turn

 

off

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server

 

and

 

operating

 

system.

 

2.

   

If

 

the

 

RXE-100

 

is

 

connected

 

to

 

power,

 

unplug

 

the

 

power

 

cord

 

and

 

wait

 

at

 

least

 

ten

 

seconds

 

before

 

you

 

plug

 

it

 

in

 

again;

 

then,

 

connect

 

the

 

RXE-100

 

to

 

your

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

your

 

server

 

and

 

the

 

RXE-100.

 

3.

   

Turn

 

on

 

the

 

server.

 

If

 

the

 

RXE-100

 

does

 

not

 

automatically

 

turn

 

on,

 

repeat

 

step

 

1

 

and

 

step

 

2.

 

4.

   

Update

 

the

 

device

 

drivers

 

for

 

any

 

adapters

 

installed

 

in

 

the

 

RXE-100.

 

5.

   

(Remote

 

Supervisor

 

Adapter

 

II-EXA

 

models

 

only)

 

Continue

 

with

 

“Updating

 

the

 

ATI

 

Radeon

 

video

 

device

 

driver

 

(Remote

 

Supervisor

 

Adapter

 

II-EXA

 

models

 

only).”

 

6.

   

Continue

 

with

 

“Updating

 

the

 

Broadcom

 

NetXtreme

 

Gigabit

 

Ethernet

 

adapter

 

device

 

driver”

 

on

 

page

 

6.

Updating

 

the

 

ATI

 

Radeon

 

video

 

device

 

driver

 

(Remote

 

Supervisor

 

Adapter

 

II-EXA

 

models

 

only)

 

If

 

your

 

server

 

has

 

a

 

Remote

 

Supervisor

 

Adapter

 

II-EXA

 

installed,

 

complete

 

the

 

following

 

steps

 

to

 

install

 

the

 

ATI

 

Radeon

 

video

 

device

 

driver:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

 

4.

   

From

 

the

 

Video\RSA2\

 

directory,

 

run

 

the

 

SETUP.EXE

 

program.

 

5.

   

Follow

 

the

 

on-screen

 

instructions

 

to

 

install

 

the

 

device

 

driver.

 

6.

   

When

 

the

 

device

 

driver

 

installation

 

is

 

complete,

 

select

 

Yes

 

I

 

want

 

to

 

restart

 

my

 

computer

 

now;

 

then,

 

click

 

Finish.

 

7.

   

Continue

 

with

 

“Updating

 

the

 

Broadcom

 

NetXtreme

 

Gigabit

 

Ethernet

 

adapter

 

device

 

driver”

 

on

 

page

 

6.
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Updating

 

the

 

Broadcom

 

NetXtreme

 

Gigabit

 

Ethernet

 

adapter

 

device

 

driver

 

Complete

 

the

 

following

 

steps

 

to

 

update

 

the

 

device

 

driver

 

for

 

the

 

on-board

 

Ethernet

 

controller:

  

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

  

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

  

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

  

4.

   

Right-click

 

the

 

My

 

Computer

 

icon;

 

then,

 

select

 

Manage

 

from

 

the

 

menu.

  

5.

   

Click

 

Device

 

Manager.

 

Select

 

the

 

Ethernet

 

Controller

 

icon,

 

located

 

underneath

 

the

 

Other

 

Devices

 

icon.

 

Right-click

 

the

 

device;

 

then,

 

select

 

Update

 

Driver

 

from

 

the

 

menu.

  

6.

   

From

 

the

 

Welcome

 

to

 

Hardware

 

Update

 

Wizard

 

select

 

Install

 

from

 

a

 

specific

 

location

 

(Advanced)

 

and

 

click

 

Next.

  

7.

   

Select

 

Search

 

for

 

best

 

drivers

 

in

 

these

 

locations;

 

then,

 

select

 

Search

 

removable

 

media

 

(floppy,

 

CDROM...)

 

and

 

click

 

Next.

  

8.

   

When

 

the

 

System

 

found

 

a

 

driver

 

for

 

your

 

device

 

prompt

 

displays,

 

click

 

Next

 

to

 

install

 

the

 

driver.

  

9.

   

When

 

prompted

 

that

 

the

 

device

 

driver

 

installation

 

has

 

completed,

 

click

 

Finished.

 

10.

   

Repeat

 

steps

 

5

 

through

 

9

 

for

 

the

 

other

 

on-board

 

Ethernet

 

controller.

 

11.

   

Continue

 

with

 

“Updating

 

the

 

LSI

 

1030

 

on-board

 

SCSI

 

device

 

driver.”

Updating

 

the

 

LSI

 

1030

 

on-board

 

SCSI

 

device

 

driver

 

Complete

 

the

 

following

 

steps

 

to

 

update

 

the

 

device

 

driver

 

for

 

the

 

on-board

 

SCSI

 

controller:

  

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

  

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

  

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

  

4.

   

Right-click

 

the

 

My

 

Computer

 

icon;

 

then,

 

select

 

Manage

 

from

 

the

 

menu.

  

5.

   

Click

 

Device

 

Manager.

 

Select

 

the

 

LSI

 

1030

 

SCSI

 

adapter

 

icon,

 

located

 

underneath

 

the

 

SCSI

 

and

 

RAID

 

Controllers

 

icon.

 

Right-click

 

the

 

device;

 

then,

 

select

 

Update

 

Driver

 

from

 

the

 

menu.

  

6.

   

From

 

the

 

Welcome

 

to

 

Hardware

 

Update

 

Wizard

 

select

 

Install

 

from

 

a

 

specific

 

location

 

(Advanced)

 

and

 

click

 

Next.

  

7.

   

Select

 

Search

 

for

 

best

 

drivers

 

in

 

these

 

locations;

 

then,

 

select

 

Search

 

removable

 

media

 

(floppy,

 

CDROM...)

 

and

 

click

 

Next.

  

8.

   

When

 

the

 

System

 

found

 

a

 

driver

 

for

 

your

 

device

 

prompt

 

displays,

 

click

 

Next

 

to

 

install

 

the

 

driver.

  

9.

   

When

 

prompted

 

that

 

the

 

device

 

driver

 

installation

 

has

 

completed,

 

click

 

Finished.

 

10.

   

When

 

prompted

 

to

 

restart

 

the

 

server,

 

click

 

Yes

 

to

 

restart.

 

11.

   

Repeat

 

steps

 

5

 

through

 

10

 

for

 

the

 

other

 

on-board

 

SCSI

 

controller.

 

12.

   

Continue

 

with

 

“Updating

 

the

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

device

 

driver

 

and

 

firmware”

 

on

 

page

 

7.

  

6



Updating

 

the

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

device

 

driver

 

and

 

firmware

 

Complete

 

the

 

following

 

steps

 

to

 

update

 

the

 

device

 

driver

 

for

 

an

 

IBM

 

FAStT

 

FC

 

133

 

Host

 

Bus

 

Adapter

 

installed

 

in

 

your

 

server:

  

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

  

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

  

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

  

4.

   

Right-click

 

the

 

My

 

Computer

 

icon;

 

then,

 

select

 

Manage

 

from

 

the

 

menu.

  

5.

   

Click

 

Device

 

Manager.

 

Select

 

the

 

QLogic

 

QLA23xx

 

Fibre

 

Channel

 

adapter

 

icon,

 

located

 

underneath

 

the

 

SCSI

 

and

 

RAID

 

Controllers

 

icon.

 

Right-click

 

the

 

device;

 

then,

 

select

 

Update

 

Driver

 

from

 

the

 

menu.

  

6.

   

From

 

the

 

Welcome

 

to

 

Hardware

 

Update

 

Wizard

 

select

 

Install

 

from

 

a

 

specific

 

location

 

(Advanced)

 

and

 

click

 

Next.

  

7.

   

Select

 

Search

 

for

 

best

 

drivers

 

in

 

these

 

locations;

 

then,

 

select

 

Search

 

removable

 

media

 

(floppy,

 

CDROM...)

 

and

 

click

 

Next.

 

Note:

  

If

 

Windows

 

does

 

not

 

find

 

the

 

device

 

driver,

 

complete

 

the

 

following

 

steps:

 

a.

   

Click

 

Back;

 

then,

 

select

 

Don’t

 

search,

 

I

 

will

 

choose

 

the

 

driver

 

to

 

install

 

and

 

click

 

Next.

 

b.

   

Select

 

the

 

Show

 

compatible

 

hardware

 

checkbox;

 

then,

 

select

 

QLA23xx

 

PCI

 

Fibre

 

Channel

 

Adapter

 

from

 

the

 

list.

 

c.

   

Click

 

the

 

Have

 

Disk

 

button

 

and

 

navigate

 

to

 

the

 

HBA\oemsetup.inf

 

file

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD;

 

then,

 

click

 

Next.

 

8.

   

When

 

the

 

System

 

found

 

a

 

driver

 

for

 

your

 

device

 

prompt

 

displays,

 

click

 

Next

 

to

 

install

 

the

 

driver.

  

9.

   

When

 

prompted

 

that

 

the

 

device

 

driver

 

installation

 

has

 

completed,

 

click

 

Finished.

 

10.

   

Repeat

 

step

 

5

 

through

 

step

 

9

 

for

 

a

 

second

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

installed

 

in

 

your

 

server.

 

11.

   

Shut

 

down

 

the

 

operating

 

system

 

and

 

restart

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server

 

and

 

operating

 

system.

 

12.

   

Insert

 

the

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter

 

firmware

 

diskette

 

that

 

you

 

created

 

earlier

 

into

 

the

 

diskette

 

drive

 

on

 

the

 

server.

 

The

 

server

 

will

 

start

 

from

 

the

 

diskette

 

and

 

wait

 

at

 

a

 

RAM

 

disk

 

C:\

 

prompt.

 

13.

   

From

 

the

 

command

 

line,

 

type

 

’flasutil

 

/l

 

/f

 

/o

 

ql2312rm.bin’

 

and

 

press

 

Enter.

 

This

 

will

 

update

 

the

 

BIOS

 

and

 

NVRAM

 

firmware

 

for

 

all

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapters

 

installed

 

in

 

your

 

server.

 

Note:

  

For

 

more

 

information

 

on

 

this

 

program

 

you

 

can

 

type

 

flasutil

 

/?

 

at

 

the

 

command

 

prompt

 

or

 

refer

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

FAStT

 

FC2-133

 

Host

 

Bus

 

Adapter.

 

14.

   

When

 

the

 

program

 

completes,

 

remove

 

the

 

diskette

 

from

 

the

 

diskette

 

drive

 

and

 

restart

 

the

 

server.

 

15.

   

Continue

 

with

 

“Installing

 

TotalStorage

 

FAStT

 

Storage

 

Manager

 

software”

 

on

 

page

 

8.

  

7



Installing

 

TotalStorage

 

FAStT

 

Storage

 

Manager

 

software

 

Before

 

you

 

install

 

the

 

TotalStorage

 

FAStT

 

Storage

 

Manager

 

software,

 

see

 

the

 

documentation

 

that

 

comes

 

with

 

your

 

hardware

 

for

 

specific

 

configuration

 

information.

 

A

 

specific

 

configuration

 

might

 

be

 

required

 

for

 

your

 

hardware

 

to

 

support

 

the

 

storage

 

management

 

software

 

in

 

a

 

clustered

 

environment.

 

You

 

can

 

only

 

install

 

the

 

software

 

on

 

cluster-only

 

nodes

 

or

 

cluster

 

nodes

 

and

 

management

 

workstations.

 

Management

 

workstations:

 

A

 

management

 

workstation

 

is

 

a

 

server

 

that

 

you

 

use

 

to

 

manage

 

the

 

storage

 

subsystem.

 

You

 

can

 

attach

 

the

 

management

 

workstation

 

to

 

the

 

storage

 

subsystem

 

in

 

the

 

following

 

ways:

 

v

   

Through

 

a

 

TCP/IP

 

Ethernet

 

connection

 

to

 

the

 

controllers

 

in

 

the

 

subsystem

 

v

   

Through

 

a

 

TCP/IP

 

network

 

connection

 

to

 

a

 

cluster

 

node

 

with

 

the

 

host-agent

 

software

 

installed

You

 

must

 

install

 

storage

 

management

 

software

 

on

 

a

 

management

 

workstation

 

in

 

the

 

following

 

order:

 

1.

   

Microsoft

 

Virtual

 

Machine;

 

see

 

“Installing

 

Microsoft

 

Virtual

 

Machine”

 

2.

   

Storage

 

Manager

 

client

 

(SMclient);

 

see

 

“Installing

 

SMclient”

 

on

 

page

 

9

Cluster

 

nodes:

 

The

 

cluster

 

nodes

 

attach

 

directly

 

to

 

the

 

storage

 

subsystem

 

through

 

a

 

Fibre

 

Channel

 

I/O

 

path.

 

You

 

must

 

install

 

storage

 

management

 

software

 

on

 

each

 

cluster

 

node

 

in

 

the

 

following

 

order:

 

1.

   

Microsoft

 

Virtual

 

Machine;

 

see

 

“Installing

 

Microsoft

 

Virtual

 

Machine”

 

2.

   

Storage

 

Manager

 

client

 

(SMclient);

 

see

 

“Installing

 

SMclient”

 

on

 

page

 

9

 

3.

   

Remote

 

Disk

 

Access

 

Control

 

(RDAC);

 

see

 

“Installing

 

RDAC”

 

on

 

page

 

9

 

4.

   

Storage

 

Manager

 

agent

 

(SMagent);

 

see

 

“Installing

 

SMagent”

 

on

 

page

 

10

Installing

 

Microsoft

 

Virtual

 

Machine

 

Complete

 

the

 

following

 

steps

 

to

 

install

 

Microsoft

 

Virtual

 

Machine

 

on

 

management

 

workstations

 

or

 

cluster

 

nodes:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

 

4.

   

From

 

the

 

FAStT.WS03\

 

directory,

 

run

 

the

 

MSJavx86-3805.EXE

 

program.

 

5.

   

Follow

 

the

 

on-screen

 

instructions

 

to

 

install

 

the

 

software.

 

Note:

  

When

 

prompted

 

to

 

restart

 

the

 

server,

 

select

 

No,

 

do

 

not

 

restart

 

the

 

system

 

at

 

this

 

time.

 

6.

   

Continue

 

with

 

“Installing

 

SMclient”

 

on

 

page

 

9.

  

8



Installing

 

SMclient

 

Complete

 

the

 

following

 

steps

 

to

 

install

 

the

 

SMclient

 

software

 

on

 

management

 

workstations

 

or

 

cluster

 

nodes:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

 

4.

   

From

 

the

 

FAStT.WS03\

 

directory,

 

run

 

the

 

SMclient-WS32-0840G501.EXE

 

program.

 

5.

   

Follow

 

the

 

on-screen

 

instructions

 

to

 

install

 

the

 

software.

 

Read

 

and

 

accept

 

the

 

End

 

User

 

License

 

Agreement

 

(EULA),

 

when

 

prompted.

 

6.

   

Click

 

Finish

 

when

 

the

 

software

 

installation

 

is

 

complete.

 

7.

   

Verify

 

that

 

the

 

SMclient

 

software

 

installed

 

correctly:

 

a.

   

Select

 

Start→All

 

Programs

 

and

 

verify

 

that

 

the

 

IBM

 

FAStT

 

Storage

 

Manager

 

8

 

Client

 

is

 

displayed

 

in

 

the

 

list

 

of

 

installed

 

programs.

 

Note:

  

If

 

the

 

program

 

is

 

not

 

displayed,

 

repeat

 

step

 

3

 

through

 

step

 

6.

 

If

 

the

 

program

 

is

 

still

 

not

 

displayed,

 

contact

 

your

 

IBM

 

support

 

representative.

 

b.

   

Select

 

Start→All

 

Programs→Administrative

 

Tools→Services

 

to

 

display

 

the

 

Services

 

window.

 

c.

   

Verify

 

that

 

the

 

IBM

 

FAStT

 

Storage

 

Manager

 

8

 

Event

 

Monitor

 

is

 

displayed

 

with

 

startup

 

set

 

to

 

Automatic

 

and

 

the

 

status

 

Started.

 

If

 

the

 

service

 

is

 

not

 

started,

 

click

 

Start.

 

Contact

 

your

 

IBM

 

support

 

representative

 

if

 

you

 

have

 

continued

 

problems.
8.

   

Continue

 

with

 

“Installing

 

RDAC.”

Installing

 

RDAC

 

RDAC

 

contains

 

the

 

multipath

 

device

 

driver

 

that

 

is

 

required

 

for

 

the

 

FAStT

 

storage

 

controller

 

failover

 

support.

 

Make

 

sure

 

that

 

you

 

have

 

at

 

least

 

1

 

MB

 

of

 

available

 

hard

 

disk

 

space

 

on

 

each

 

cluster

 

node

 

and

 

that

 

the

 

appropriate

 

host

 

bus

 

adapter

 

is

 

already

 

installed.

 

Complete

 

the

 

following

 

steps

 

to

 

install

 

the

 

RDAC

 

software

 

on

 

cluster

 

nodes:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

 

4.

   

From

 

the

 

FAStT.WS03\

 

directory,

 

run

 

the

 

SMrdac-WS32-08403503.EXE

 

program.

 

5.

   

Follow

 

the

 

on-screen

 

instructions

 

to

 

install

 

the

 

software.

 

6.

   

When

 

the

 

software

 

installation

 

is

 

complete,

 

select

 

Yes

 

I

 

want

 

to

 

restart

 

my

 

computer

 

now;

 

then,

 

click

 

Finish.

 

7.

   

When

 

the

 

server

 

restarts,

 

log

 

in

 

to

 

the

 

server

 

again

 

as

 

the

 

Administrator.

 

8.

   

Verify

 

that

 

the

 

RDAC

 

software

 

installed

 

correctly:

 

a.

   

Select

 

Start→All

 

Programs→Accessories→System

 

Tools→System

 

Information

 

to

 

display

 

the

 

System

 

Information

 

window.

 

b.

   

Verify

 

that

 

the

 

rdacbus

 

is

 

displayed

 

in

 

the

 

list

 

of

 

system

 

drivers

 

under

 

Software

 

Environment

 

and

 

the

 

state

 

is

 

Running

 

with

 

a

 

status

 

of

 

OK.

 

Note:

  

If

 

the

 

device

 

driver

 

is

 

not

 

started,

 

repeat

 

step

 

3

 

through

 

step

 

7.

 

If

 

the

 

device

 

driver

 

is

 

still

 

not

 

started,

 

contact

 

your

 

IBM

 

support

 

representative.
9.

   

Continue

 

with

 

“Installing

 

SMagent”

 

on

 

page

 

10.

  

9



Installing

 

SMagent

 

You

 

must

 

install

 

the

 

SMagent

 

software

 

if

 

you

 

intend

 

to

 

manage

 

the

 

storage

 

subsystem

 

using

 

the

 

host-agent

 

method.

 

Before

 

installing

 

the

 

SMagent

 

software

 

on

 

a

 

cluster

 

node,

 

ensure

 

the

 

following

 

conditions

 

are

 

met:

 

v

   

Each

 

cluster

 

node

 

has

 

at

 

least

 

1

 

MB

 

of

 

available

 

hard

 

disk

 

space

 

v

   

RDAC

 

is

 

already

 

installed

 

on

 

each

 

cluster

 

node;

 

see

 

“Installing

 

RDAC”

 

on

 

page

 

9

 

v

   

Microsoft

 

Virtual

 

Machine

 

is

 

already

 

installed;

 

see

 

“Installing

 

Microsoft

 

Virtual

 

Machine”

 

on

 

page

 

8

Complete

 

the

 

following

 

steps

 

to

 

install

 

the

 

SMagent

 

software

 

on

 

cluster

 

nodes:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

 

4.

   

From

 

the

 

FAStT.WS03\

 

directory,

 

run

 

the

 

SMagent-WS32-08403500.EXE

 

program.

 

5.

   

Follow

 

the

 

on-screen

 

instructions

 

to

 

install

 

the

 

software.

 

6.

   

When

 

the

 

software

 

installation

 

is

 

complete,

 

click

 

Finish.

 

7.

   

Verify

 

that

 

the

 

SMagent

 

software

 

installed

 

correctly:

 

a.

   

Select

 

Start→All

 

Programs→Administrative

 

Tools→Services

 

to

 

display

 

the

 

Services

 

window.

 

b.

   

Verify

 

that

 

the

 

IBM

 

FAStT

 

Storage

 

Manager

 

8

 

Agent

 

is

 

displayed

 

with

 

startup

 

set

 

to

 

Automatic

 

and

 

the

 

status

 

Started.

 

If

 

the

 

service

 

is

 

not

 

started,

 

click

 

Start.

 

Contact

 

your

 

IBM

 

support

 

representative

 

if

 

you

 

have

 

continued

 

problems.

 

Note:

  

If

 

the

 

device

 

driver

 

is

 

not

 

started,

 

repeat

 

step

 

3

 

through

 

step

 

6.

 

If

 

the

 

device

 

driver

 

is

 

still

 

not

 

started,

 

contact

 

your

 

IBM

 

support

 

representative.
8.

   

Continue

 

with

 

“Updating

 

storage-subsystem

 

firmware.”

Updating

 

storage-subsystem

 

firmware

 

Complete

 

the

 

following

 

steps

 

to

 

update

 

the

 

storage-subsystem

 

firmware

 

and

 

NVSRAM:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Insert

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD

 

into

 

the

 

DVD-ROM

 

drive

 

on

 

the

 

server.

 

4.

   

Select

 

Start→All

 

Programs→IBM

 

FAStT

 

Storage

 

Manager

 

8

 

Client

 

to

 

start

 

the

 

client

 

software

 

and

 

display

 

the

 

Enterprise

 

Management

 

window.

 

Note:

  

There

 

might

 

be

 

a

 

delay

 

of

 

several

 

minutes

 

before

 

the

 

window

 

displays.

 

No

 

indication

 

of

 

progress

 

is

 

given

 

during

 

this

 

time.

 

5.

   

From

 

the

 

Enterprise

 

Management

 

window,

 

select

 

a

 

storage

 

subsystem.

 

6.

   

Select

 

Tools→Manage

 

Device

 

to

 

display

 

the

 

Subsystem

 

Management

 

window.

 

7.

   

Select

 

Storage

 

Subsystem→Download→Firmware

 

to

 

update

 

the

 

firmware.

 

Follow

 

the

 

on-screen

 

instructions.

 

Browse

 

to

 

the

 

FAStT.WS03\Firmware\

 

directory

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD,

 

when

 

prompted.

 

8.

   

Select

 

Storage

 

Subsystem→Download→NVSRAM

 

to

 

update

 

the

 

NVRAM.

 

Follow

 

the

 

on-screen

 

instructions.

 

Browse

 

to

 

the

 

FAStT.WS03\NVSRAM\

 

directory

 

on

 

the

 

IBM

 

Datacenter

 

Device

 

Drivers

 

CD,

 

when

 

prompted.

 

9.

   

Continue

 

with

 

“Completing

 

the

 

upgrade”

 

on

 

page

 

11.

  

10



Completing

 

the

 

upgrade

 

To

 

complete

 

the

 

upgrade

 

process,

 

you

 

will

 

need

 

to

 

complete

 

the

 

following

 

procedures:

 

1.

   

“Performing

 

initial

 

automatic

 

discovery

 

of

 

storage

 

subsystems”

 

2.

   

“Verifying

 

and

 

defining

 

the

 

default

 

host

 

type”

 

on

 

page

 

12

For

 

more

 

information

 

about

 

these

 

and

 

other

 

storage-subsystem

 

management

 

tasks,

 

see

 

the

 

appropriate

 

topics

 

in

 

the

 

subsystem-management

 

online

 

help.

 

Performing

 

initial

 

automatic

 

discovery

 

of

 

storage

 

subsystems

 

Complete

 

the

 

following

 

steps

 

to

 

perform

 

an

 

initial

 

automatic

 

discovery

 

of

 

storage

 

systems:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Select

 

Start→All

 

Programs→IBM

 

FAStT

 

Storage

 

Manager

 

8

 

Client

 

to

 

start

 

the

 

client

 

software

 

and

 

display

 

the

 

Enterprise

 

Management

 

window.

 

Note:

  

There

 

might

 

be

 

a

 

delay

 

of

 

several

 

minutes

 

before

 

the

 

window

 

displays.

 

No

 

indication

 

of

 

progress

 

is

 

given

 

during

 

this

 

time.

 

4.

   

Click

 

Yes

 

to

 

begin

 

an

 

initial

 

automatic

 

discovery

 

of

 

hosts

 

and

 

storage

 

subsystems

 

attached

 

to

 

the

 

local

 

subnetwork.

 

After

 

the

 

discovery

 

completes,

 

all

 

hosts

 

and

 

storage

 

subsystems

 

attached

 

to

 

the

 

local

 

subnetwork

 

are

 

displayed.

 

Note:

  

There

 

might

 

be

 

a

 

delay

 

of

 

up

 

to

 

a

 

minute

 

after

 

the

 

discovery

 

completes

 

before

 

the

 

display

 

refreshes.

 

5.

   

Verify

 

that

 

each

 

host

 

and

 

storage

 

subsystem

 

is

 

displayed

 

in

 

the

 

Enterprise

 

Management

 

window.

 

If

 

a

 

host

 

or

 

subsystem

 

is

 

not

 

displayed,

 

check

 

the

 

following:

 

v

   

Verify

 

hardware

 

connections

 

between

 

devices.

 

Refer

 

to

 

the

 

hardware

 

documentation

 

as

 

necessary.

 

v

   

See

 

the

 

Enterprise

 

Management

 

online

 

help

 

for

 

additional

 

information

 

about

 

storage

 

subsystem

 

discovery.

 

v

   

If

 

you

 

are

 

using

 

the

 

direct-management

 

method,

 

verify

 

that

 

all

 

hosts

 

and

 

storage

 

subsystems

 

are

 

connected

 

to

 

the

 

same

 

subnet

 

on

 

the

 

network.

 

v

   

If

 

you

 

are

 

using

 

the

 

host-agent

 

method,

 

ensure

 

that

 

the

 

Fibre

 

Channel

 

connection

 

between

 

the

 

host

 

and

 

storage

 

subsystems

 

is

 

correct.

Make

 

sure

 

that

 

you

 

complete

 

all

 

of

 

the

 

preparation

 

steps

 

for

 

configuring

 

the

 

storage

 

subsystems

 

for

 

a

 

directly-managed

 

system;

 

then,

 

use

 

the

 

Add

 

Device

 

option

 

to

 

add

 

the

 

IP

 

addresses

 

of

 

the

 

storage

 

subsystem.

 

Make

 

sure

 

that

 

you

 

add

 

both

 

IP

 

addresses

 

of

 

the

 

controller

 

to

 

prevent

 

the

 

partially-managed

 

device

 

error

 

message

 

from

 

displaying

 

when

 

you

 

try

 

to

 

manage

 

the

 

storage

 

subsystem.

 

Note:

  

If

 

you

 

are

 

using

 

the

 

host-agent

 

management

 

method,

 

make

 

sure

 

that

 

the

 

SMagent

 

is

 

installed

 

on

 

the

 

host.

 

Also,

 

verify

 

that

 

you

 

have

 

a

 

Fibre

 

Channel

 

connection

 

from

 

the

 

storage

 

subsystems

 

to

 

the

 

host

 

that

 

has

 

the

 

SMagent

 

installed.

 

Continue

 

with

 

“Verifying

 

and

 

defining

 

the

 

default

 

host

 

type”

 

on

 

page

 

12.
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Verifying

 

and

 

defining

 

the

 

default

 

host

 

type

 

Before

 

using

 

the

 

logical

 

drives

 

in

 

the

 

host,

 

you

 

must

 

specify

 

the

 

host

 

type.

 

The

 

host

 

type

 

determines

 

how

 

the

 

storage

 

subsystem

 

controllers

 

work

 

with

 

each

 

particular

 

operating

 

system

 

on

 

the

 

hosts

 

to

 

which

 

they

 

are

 

connected.

 

If

 

all

 

of

 

the

 

host

 

computers

 

connected

 

to

 

the

 

same

 

storage

 

subsystem

 

are

 

running

 

the

 

same

 

operating

 

system,

 

and

 

you

 

do

 

not

 

intend

 

to

 

define

 

partitioning,

 

then

 

you

 

can

 

define

 

a

 

default

 

host

 

type.

 

To

 

verify

 

the

 

current

 

default

 

host

 

type,

 

complete

 

the

 

following

 

steps:

 

1.

   

If

 

the

 

server

 

is

 

not

 

already

 

on,

 

turn

 

on

 

the

 

server

 

according

 

to

 

the

 

documentation

 

that

 

comes

 

with

 

the

 

server;

 

then,

 

wait

 

for

 

the

 

Windows

 

Server

 

2003

 

Datacenter

 

Edition

 

operating

 

system

 

to

 

start.

 

2.

   

If

 

you

 

are

 

not

 

already

 

logged

 

into

 

the

 

server,

 

log

 

in

 

to

 

the

 

server

 

as

 

the

 

Administrator.

 

3.

   

Select

 

Start→All

 

Programs→IBM

 

FAStT

 

Storage

 

Manager

 

8

 

Client

 

to

 

start

 

the

 

client

 

software

 

and

 

display

 

the

 

Enterprise

 

Management

 

window.

 

Note:

  

There

 

might

 

be

 

a

 

delay

 

of

 

several

 

minutes

 

before

 

the

 

window

 

displays.

 

No

 

indication

 

of

 

progress

 

is

 

given

 

during

 

this

 

time.

 

4.

   

Select

 

Tools→Manage

 

Device

 

to

 

display

 

the

 

Subsystem

 

Management

 

window.

 

5.

   

Select

 

View→Storage

 

Subsystem

 

profile

 

to

 

display

 

the

 

Storage

 

Subsystem

 

Profile

 

window.

 

6.

   

Click

 

the

 

Mappings

 

folder

 

tab;

 

then,

 

scroll

 

down

 

to

 

NVSRAM

 

Host

 

Type

 

Internal

 

Definitions.

 

The

 

host

 

type

 

name

 

of

 

the

 

index

 

that

 

has

 

the

 

DEFAULT

 

setting

 

next

 

to

 

it

 

is

 

the

 

default

 

host

 

type.

 

7.

   

Click

 

Close.

 

8.

   

To

 

define

 

a

 

default

 

host

 

type:

 

a.

   

Click

 

Storage

 

subsystem→Change-Default

 

host-type

 

to

 

open

 

the

 

Default

 

Host-type

 

window.

 

b.

   

Select

 

the

 

new

 

default

 

host

 

type

 

from

 

the

 

list;

 

then,

 

click

 

OK.

Important:

  

To

 

use

 

the

 

heterogeneous

 

host

 

feature,

 

you

 

must

 

do

 

the

 

following:

 

v

   

Enable

 

storage

 

partitioning.

 

Note:

  

If

 

you

 

disable

 

partitioning,

 

you

 

must

 

contact

 

your

 

IBM

 

support

 

representative

 

to

 

obtain

 

a

 

key

 

that

 

will

 

permit

 

you

 

to

 

enable

 

partitioning

 

again.

 

v

   

During

 

host-port

 

definition,

 

you

 

must

 

set

 

each

 

host

 

type

 

to

 

the

 

appropriate

 

operating

 

system

 

so

 

that

 

the

 

firmware

 

on

 

each

 

controller

 

can

 

respond

 

correctly

 

to

 

the

 

host.

From

 

the

 

Subsystem

 

Management

 

window,

 

click

 

Mappings

 

View

 

to

 

start

 

the

 

heterogeneous

 

host

 

configuration;

 

then,

 

follow

 

the

 

on-screen

 

instructions

 

to

 

define

 

the

 

heterogeneous

 

host

 

configuration.

   

First

 

Edition

 

(April

 

2004)

 

Active

 

PCI,

 

IBM,

 

Eserver,

 

ServeRAID,

 

TotalStorage,

 

xSeries,

 

and

 

the

 

e-business

 

logo

 

are

 

trademarks

 

of

 

the

 

IBM

 

Corporation

 

in

 

the

 

United

 

States,

 

other

 

countries,

 

or

 

both.

 

Microsoft

 

and

 

Windows

 

are

 

trademarks

 

of

 

Microsoft

 

Corporation

 

in

 

the

 

United

 

States,

 

other

 

countries,

 

or

 

both.

 

©

 

Copyright

 

International

 

Business

 

Machines

 

Corporation

 

2004.

 

All

 

rights

 

reserved.

 

US

 

Government

 

Users

 

Restricted

 

Rights

 

–

 

Use,

 

duplication

 

or

 

disclosure

 

restricted

 

by

 

GSA

 

ADP

 

Schedule

 

Contract

 

with

 

IBM

 

Corp.
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P/N:
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